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Introduction  

L'occupation du sol joue un rôle essentiel dans la gestion durable des ressources 

naturelles ainsi que dans la planification urbaine et régionale. Selon MADANI (2024), les 

évolutions de l'occupation du sol, souvent associées à des processus tels que l'urbanisation, 

l'agriculture, la déforestation et l'industrialisation, ont des conséquences importantes sur les 

écosystèmes, la biodiversité, les ressources en eau et le climat. 

L'objectif de ce mémoire est d'étudier les évolutions de l'occupation du sol dans la 

wilaya de Bouira en se basant sur des outils de télédétection et des systèmes d'information 

géographique (SIG). L'objectif précis consiste à dresser une carte de l'occupation du sol à 

diverses époques, à analyser les dynamiques de changement, à évaluer les conséquences 

environnementales et à formuler des recommandations pour une gestion durable. 

Afin d'atteindre ces objectifs, nous utiliserons une méthode combinée de télédétection et 

d'analyse SIG. Les données requises pour la cartographie et l'analyse des changements 

d'occupation du sol seront fournies par les images satellitaires de Landsat-8 et Sentinel-2. Les 

images seront traitées à l'aide du logiciel ENVI, qui comprendra le géoréférencement, la 

classification et l'analyse spectrale. Par la suite, les résultats seront intégrés dans un système 

d'information géographique (SIG) afin d'effectuer une analyse spatiale approfondie et de 

produire des cartes et des rapports détaillés (REZEG, 2010). 

L'étude des changements d'occupation du sol à Bouira est d'une grande pertinence car 

elle fournira une base de données essentielle pour les décideurs locaux, urbanistes et 

environnementalistes, contribuant ainsi à la compréhension des dynamiques locales 

d'utilisation des terres et offrant des perspectives précieuses pour des interventions ciblées. 

Enfin, cette recherche s'inscrit dans un cadre plus large de développement durable, soulignant 

l'importance d'une gestion équilibrée et informée des ressources naturelles (MIRANVILLE, 

2024). 

Notre manuscrit est divisé en plusieurs parties distinctes : 

 La première partie présente les généralités sur la télédétection et le SIG. Elle dresse 

un état des connaissances existantes sur le sujet. 

 La seconde partie traite des évolutions de l'occupation du sol. Les méthodes et les 

outils utilisés sont détaillés dans un cadre méthodologique, suivi d'une section de 
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résultats et de discussion qui présente les cartes de l'occupation du sol et les analyses 

de changement. 

 Enfin, des recommandations et une conclusion synthétisent les principaux résultats et 

proposent des pistes pour des recherches ultérieures. 

L'objectif de cette étude est de contribuer de manière importante à la compréhension des 

évolutions de l'occupation du sol à Bouira, tout en proposant des outils et des 

recommandations pour une gestion plus durable et efficace de ses ressources naturelles. 
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1. La télédétection et le SIG 

1.1. La télédétection 

La télédétection est la science qui permet de détecter des informations sur des objets, 

des zones ou des phénomènes à distance, généralement à l'aide de dispositifs situés sur des 

plateformes aériennes (avions ou drones) ou spatiales (satellites). Ces dispositifs permettent 

de détecter les propriétés physico-chimiques des surfaces, telles que l’humidité, la 

température, la rugosité, la composition minéralogique et chimique des sols et des roches 

(Grunwald et al., 2015). Cette technique est largement utilisée dans de nombreux domaines 

tels que l'agriculture, la géologie, la météorologie, l'océanographie, l'urbanisme et 

l'environnement (Huang et al., 2018). 

Les données de télédétection collectées par des supports de capteurs seront analysées à 

l'aide de logiciels et programmes. La télédétection englobe plusieurs méthodes et techniques 

pour recueillir des données à distance sur la surface de la Terre et l'atmosphère 

(ZERROUGUI, 2023). 

1.1.2. Objectifs 

L'objectif principal de la télédétection est de cartographier les ressources terrestres et 

d'assurer leur suivi. Elle offre une méthode précise et rentable pour obtenir des données en 

temps utile, facilitant la gestion intégrée de l'environnement et des ressources naturelles 

(CALOZ et COLLET, 2001), 

- Les principaux objectifs de la télédétection sont selon (ZERROUGUI, 2023) : 

 Observation et surveillance : Observer et surveiller l'état de l'environnement, des 

océans, des terres agricoles, des forêts, etc. 

 Cartographie : Créer des cartes précises des surfaces terrestres et marines. 

 Gestion des ressources naturelles : Évaluer et gérer les ressources naturelles telles que 

l'eau, les minéraux, les forêts et les terres agricoles. 

 Prévention et gestion des catastrophes : Détecter et suivre les catastrophes naturelles 

telles que les incendies de forêt, les inondations, les tremblements de terre, les 

ouragans, etc. 

 Urbanisme et aménagement du territoire : Aider à la planification urbaine et à 

l'aménagement du territoire. 
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1.1.3. Domaines d'application 

- La télédétection est utilisée dans de nombreux domaines Selon (DOUFFI ,2020)  : 

 Agriculture : Surveillance des cultures, estimation des rendements, gestion de 

l'irrigation. 

 Foresterie : Inventaire forestier, suivi de la déforestation, gestion des feux de forêt. 

 Environnement : Surveillance des écosystèmes, suivi de la biodiversité, gestion des 

zones protégées. 

 Hydrologie : Surveillance des ressources en eau, gestion des bassins versants, 

prévision des inondations. 

 Océanographie : Étude des courants océaniques, suivi des marées, surveillance des 

écosystèmes marins. 

 Géologie : Cartographie géologique, exploration minière, surveillance des glissements 

de terrain. 

 Urbanisme : Planification urbaine, suivi de l'étalement urbain, gestion des 

infrastructures. 

1.1.4.Processus de la télédétection 

L'analyse des images de télédétection vise à interpréter la nature et la fonction des 

objets positionnés. Le processus d'interprétation peut être visuel ou automatique et transforme 

les données des images satellitaires en informations géoréférencées (ANDRIEU et al ., 2008). 

Le processus de la télédétection comprend plusieurs étapes : 

1. Acquisition des données : Utilisation de capteurs pour capturer des images ou des 

données sur les objets ou les surfaces à étudier. Les capteurs peuvent être passifs 

(capturant la lumière réfléchie par le soleil) ou actifs (émettant leur propre signal, 

comme le radar ou le LIDAR). 

2. Prétraitement des données : Correction des erreurs et des distorsions dans les 

données brutes, telles que les corrections atmosphériques, radiométriques et 

géométriques. 

3. Interprétation et analyse des données : Utilisation de techniques d'analyse d'images 

et de traitement des données pour extraire des informations significatives. Cela peut 

inclure la classification des types de terrain, l'estimation des indices de végétation, la 

détection des changements, etc. 
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4. Validation et vérification : Comparaison des résultats de la télédétection avec des 

données de terrain ou d'autres sources pour s'assurer de leur précision et de leur 

fiabilité. 

5. Diffusion et utilisation des données : Partage des informations extraites avec les 

utilisateurs finaux, qui peuvent être des chercheurs, des gestionnaires de ressources, 

des décideurs politiques, etc. 

1.1.5. Les principales méthodes de télédétection 

1.1.5.1. La Télédétection Passive (Télédétection optique) 

1.1.5.5. La Télédétection par Sonar 

1.1.5.2. Télédétection Multispectrale 

Capture des images dans plusieurs bandes spectrales larges (généralement 3 à 10) utilisé 

dans l'agriculture de précision, la surveillance des ressources en eau, les études 

environnementales (LAZRI, 2013). 

a. Télédétection dans le visible et le proche infrarouge (VNIR) : utilise la lumière visible 

(400-700 nm) et le proche infrarouge (700-1400 nm), et utilisé dans la cartographie, la 

surveillance des cultures, l'étude des forêts, la gestion des ressources en eau. 

b. Télédétection dans l'infrarouge thermique (TIR): mesure les émissions thermiques (3 14 

μm) des objets, utile pour détecter les températures de surface, donc on l'utilise dans la 

surveillance des feux de forêt, les études volcaniques, l'analyse des îlots de chaleur urbains. 

1.1.5.3. La Télédétection Hyper spectrale 

Ce type de capteurs fournit des images dans de nombreuses bandes spectrales étroites 

(souvent des centaines), permettant une identification précise des matériaux. Ces images sont 

utilisées dans l'identification des minéraux, analyse de la composition végétale, détection de la 

pollution (ZERROUGUI, 2023). 

1.1.5.4. La Télédétection Micro-onde Passive 

Elle mesure les émissions naturelles de micro-ondes de la surface terrestre, cette méthode est 

très utile dans la surveillance de l'humidité du sol, l'étude de la neige et de la glace, la 

météorologie (ZERROUGUI, 2023). 

Cette méthode utilise des ondes sonores pour cartographier les fonds marins et les objets 

sous l'eau (Bathymétrie, cartographie des habitats marins, détection des épaves) (LAZRI, 

2013). 
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Figure 01 : Télédétection active et passive (LAZRI, 2013). 

1.1.5.6. La Télédétection Active 

Les capteurs actifs émettent leur propre source d'énergie (comme le radar ou le lidar) et 

mesurent la réflexion de cette énergie par les objets terrestres. La télédétection active est 

utilisée dans la topographie, la surveillance des déformations du sol, la détection des objets 

sous la végétation dense (GUILLET, 1991). 

1.1.5.6.1. La Télédétection Radar (Radar à ouverture synthétique (SAR)) 

Utilise des ondes radio (micro-ondes) pour produire des images haute résolution, 

indépendamment des conditions météorologiques et de la lumière. Les images radar ont 

différentes applications telles que la cartographie topographique, la surveillance des glaciers, 

la détection des mouvements du sol, la surveillance maritime (GUILLET, 1991). 

1.1.5.6.2. Le Lidar (Light Detection and Ranging) 

Utilise des impulsions laser pour mesurer la distance à un objet et créer des modèles 

numériques de terrain (MNT) et des modèles numériques de surface (MNS), utilisé 

généralement dans la cartographie topographique détaillée, les études forestières, 

l’archéologie, gestion des risques naturels (DAUMARD, 2010). 
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Ces méthodes sont complémentaires et sont souvent utilisées ensemble pour obtenir 

des informations complètes et précises sur la surface terrestre et ses changements. 

1.2.Un Système d'Information Géographique (SIG)  

Est un système informatique conçu pour capturer, stocker, manipuler, analyser, gérer et 

présenter tous types de données géographiques ou spatiales. Le SIG permet de visualiser, 

interpréter et comprendre des données spatiales de diverses façons, révélant des relations, des 

modèles et des tendances (KOUBA, 2018). 

1.2.1. Fonctionnalités 

Les principales fonctionnalités d'un SIG incluent LONGLEY et al. (2005), repris par 

BON (2011) : 

1. Capture des données : Entrée de données géographiques provenant de diverses 

sources, telles que des cartes papier, des images satellites, des GPS, etc. 

2. Stockage des données : Organisation et stockage des données dans des bases de 

données géospatiales. 

3. Gestion des données : Mise à jour, manipulation et maintenance des données 

géographiques. 

4. Analyse des données : Exécution d'analyses spatiales, telles que la superposition de 

couches, l'analyse de proximité, la modélisation des terrains, etc. 

5. Visualisation des données : Création de cartes, de graphiques et d'autres 

représentations visuelles pour faciliter la compréhension des données spatiales. 

6. Partage des données : Diffusion des informations géographiques à travers des 

rapports, des cartes interactives en ligne, des applications web SIG, etc. 

1.2.2. Types de données dans un SIG 

Les données dans un SIG peuvent être classées en deux catégories principales : 

1. Données vectorielles : Représentées par des points, des lignes et des polygones. Par 

exemple (SANDERS, 2006)  : 

o Points : Emplacements de puits, arbres, villes. 

o Lignes : Routes, rivières, lignes électriques. 

o Polygones : Parcelles de terrain, zones urbaines, forêts. 

2. Données matricielles (raster) : Représentées par des grilles de pixels, où chaque 

pixel a une valeur correspondant à une caractéristique spécifique. Par exemple : 

o Images satellites. 

o Modèles numériques de terrain (MNT). 
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o Cartes de température ou de précipitations (MATHIAN et SANDERS, 2014). 

1.2.3. Objectifs généraux des SIG 

Les objectifs généraux des SIG incluent Selon (OCCELLI,  2014)  : 

1. Améliorer la prise de décision : Fournir des outils et des informations pour aider les 

décideurs à comprendre les enjeux spatiaux et à prendre des décisions éclairées. 

2. Gestion des ressources : Aider à la gestion et à la conservation des ressources 

naturelles, comme l'eau, les forêts et les sols. 

3. Planification et aménagement du territoire : Faciliter la planification urbaine et 

rurale, la gestion des infrastructures et l'aménagement du territoire. 

4. Analyse environnementale : Permettre l'analyse des impacts environnementaux, la 

surveillance des écosystèmes et la gestion des zones protégées. 

5. Réponse aux urgences : Aider à la préparation, à la gestion et à la réponse aux 

situations d'urgence, telles que les catastrophes naturelles. 

6. Transports et logistique : Optimiser les réseaux de transport, la gestion des itinéraires 

et la planification logistique. 

7. Recherche scientifique : Fournir des outils pour la recherche en géographie, en 

écologie, en climatologie, en géologie, et dans d'autres domaines scientifiques. 

Un SIG est un outil polyvalent qui trouve des applications dans une multitude de 

domaines, offrant des capacités puissantes pour l'analyse et la gestion des informations 

géographiques. 
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2. Changement d'occupation du Sol  

2.1. Généralité 

 Le changement d'occupation du sol est un phénomène complexe qui se réfère à la 

modification de la manière dont les terres sont utilisées et couvertes par des activités 

humaines et naturelles. Ce concept englobe une variété de transformations, incluant les 

modifications des types de végétation, la croissance urbaine, la transformation des terres 

agricoles, la destruction des forêts, la reforestation et la dégradation des zones humides 

(JOSEPH, 2022). 

2.2. Définition du Changement d'Occupation du Sol 

Le changement d'occupation du sol désigne l'altération des utilisations et des couvertures 

des terres sur une période de temps donnée, résultant de divers facteurs tels que le 

développement économique, la croissance démographique, les politiques 

environnementales, et les phénomènes naturels. Cette transformation peut être observée à 

travers des modifications dans les paysages, la biodiversité,  et les écosystèmes locaux 

(BOUSSOUGOU, 2017). 

2.2.1. Concepts Liés au Changement d'Occupation du Sol 

 Utilisation du Sol (Land Use) 

Cela fait référence aux activités humaines spécifiques entreprises sur une parcelle de 

terrain, telles que l'agriculture, la construction urbaine, les zones industrielles, les espaces 

récréatifs, etc. Les changements d'utilisation du sol sont souvent dictés par des besoins 

économiques, sociaux et politiques (MENASRA, 2023). 

 Couverture du Sol (Land Cover) 

La couverture du sol décrit les caractéristiques physiques de la surface terrestre, y compris la 

végétation naturelle, les terres agricoles, les zones urbaines, les forêts, les plans d'eau, etc. Les 

changements de couverture du sol sont souvent détectés via l'imagerie satellitaire et les 

systèmes d'information géographique (SIG) (MENASRA, 2023). 
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 Déforestation et Reforestation 

La déforestation se réfère à la conversion des forêts en terres non forestières, 

généralement pour des usages agricoles ou urbains. La reforestation, à l'inverse, est le 

processus de replantation de forêts sur des terres qui avaient été déboisées (MENASRA, 

2023). 

 Urbanisation 

L'urbanisation est l'expansion des zones urbaines à mesure que les populations 

augmentent et se déplacent des zones rurales vers les villes. Cela inclut la construction de 

bâtiments, routes, infrastructures, et la création de zones résidentielles, commerciales et 

industrielles (MENASRA, 2023). 

 Désertification 

La désertification correspond à la destruction des terres dans les régions arides, semi-

arides et subhumides sèches, due à différents éléments, tels que les changements 

climatiques et les activités humaines. Ceci conduit à une diminution de la productivité des 

sols et à une diminution de la diversité biologique (BELMAHDI, 2022). 

 Agriculture Intégrée et Intensive 

L'agriculture intégrée se concentre sur la gestion durable des ressources agricoles en 

combinant les cultures, le bétail et parfois l'aquaculture. L'agriculture intensive, en revanche, 

implique une utilisation élevée d'intrants (comme les engrais, les pesticides) pour maximiser 

les rendements (BELMAHDI, 2022). 

 Conservation des Terres 

L'objectif de la conservation des terres est de garantir la protection et la gestion durable des 

terres afin de préserver les ressources naturelles et la diversité biologique. Selon BELMAHDI 

(2022), cela englobe des méthodes telles que l'agroforesterie, les zones protégées et les 

réserves naturelles. 

2.2.1. Implications du Changement d'Occupation du Sol 

D'après les recherches de MIRANVILLE (2024), les modifications de l'utilisation du sol 

ont des conséquences importantes sur l'environnement et les sociétés, notamment : 
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 Environnementales : La biodiversité diminue, les habitats se dégradent, les cycles 

hydrologiques sont altérés et les changements climatiques sont à la fois locaux et 

globaux. 

 Socio-économiques : Changements dans les modes de vie, déplacements de 

populations, conflits concernant l'accès aux ressources et modifications de la qualité 

de vie. 

 Politiques et de Gestion : Il est essentiel d'adopter des politiques de gestion durable 

des terres, de planifier les villes et de mettre en place des stratégies de préservation 

environnementale. 

2.3. L’Occupation du Sol de la Wilaya de Bouir 

La répartition de l'occupation du sol dans la wilaya de Bouira est classée en plusieurs 

catégories selon l'Inventaire forestier national (IFN) de 2008. Les forêts naturelles, les maquis 

et les reboisements, qui représentent 12 % de la superficie totale de la wilaya, sont 

représentées par une superficie forestière de 94 049 hectares. Il est essentiel de préserver ces 

zones forestières afin de préserver la biodiversité, de réguler le climat local et de prévenir 

l'érosion des sols. 

La superficie des terres de parcours, principalement destinées au pâturage du bétail, est 

de 125 830 hectares, soit 16 % de la superficie totale de la wilaya. Ces régions jouent un rôle 

crucial dans l'élevage, un élément clé de l'agriculture locale, faisant partie de la production de 

viande, de lait et de laine. Finalement, les zones non cultivables, telles que les zones 

rocheuses et les déserts, représentent 7 416 hectares, soit 1 % de la superficie totale. Malgré 

l'absence d'utilisation agricole directe de ces terres, elles contribuent à la gestion des 

ressources naturelles et à la préservation de certains habitats. 

L'analyse de l'occupation du sol à Bouira met en évidence la diversité des utilisations 

des terres et la nécessité de pratiques de gestion intégrées et durables. La gestion efficace de 

ces ressources est essentielle pour soutenir le développement économique, préserver 

l'environnement et améliorer la qualité de vie des populations locales (Figure 02). 
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        Figure 02 : Aménagement du sol de la wilaya de Bouira (DSA, 2012). 

2.4.Revue des Études Antérieures sur le Changement d'Occupation du Sol 

Le changement d'occupation du sol est un sujet de recherche multidisciplinaire qui a 

attiré l'attention des chercheurs du monde entier en raison de ses implications 

environnementales, sociales et économiques. Cette revue des études antérieures met en 

lumière les principaux travaux effectués dans ce domaine, en se concentrant particulièrement 

sur les approches méthodologiques, les résultats clés, et les lacunes dans la littérature 

(HOANG et al., 2009). 

2.4.1. Quelques études dans le monde entier  

La revue des études antérieures sur le changement d'occupation du sol montre une 

variété de méthodes et de résultats dans divers contextes géographiques. Voici quelques 

exemples : 
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Tableau I : La revue des études dans le monde entier  

L’année Pays (Régions) Les techniques Réferencer 

 

2011 

Liban (Béqaa Ouest) Photos aériennes, 

images satellitaires 

 

Sparfel, 2011 

 

2009 

Vietnam (bassin 

versant de la rivière 

Câu) 

Classifications de 

sol, analyses de 

composantes 

principales 

 

Hoang et al., 2009 

 

2013 

France (zone côtière 

du pays de Brest) 

Données hétérogènes 

(diverses sources de 

données 

géospatiales) 

 

 

 

Coulibaly, 2013 

 

2015 

Burkina Faso 

(bassins versants de 

la Mékrou) 

Données de 

télédétection 

 

OUEDRAOGO et 

al., 2015 

 

2011 

 

Bénin 

Données de 

télédétection 

 

ACHILLEAS,2011 

 

Ces études démontrent l'importance de l'analyse des changements d'occupation des sols 

pour comprendre les impacts des activités humaines sur l'environnement et pour planifier des 

politiques de gestion des ressources naturelles. 

Tableau II : La revue des études dans La régions de Bouira 

L’année Pays (Régions) La Techniques Réferencer 

2019 El Esnam Analyse de sol Dr. A. Benslimane 

2020 Sour El Ghozlane Étude hydrologique Prof. M. Lounis 

2021 Aïn Bessem Cartographie par drones Dr. S. Kouider 

2022 Lakhdaria Modélisation climatique Dr. R. Belkacem 

2023 Bechloul télédétection Prof. H. Meddour 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

Chapitre III 

Matériel et méthodes 
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3.1. Présentation de la zone d'étude 

3.1.1. Limite administratif  

La Wilaya de Bouira, établie selon les dispositions de l'ordonnance n° 74/69 du 02 

juillet 1974, qui a redéfini l'organisation territoriale des wilayas, est située dans la région Nord 

- Centre de l'Algérie, à environ 120 kilomètres au sud-est d'Alger. Bouira est le chef-lieu de la 

wilaya et appartient à la région centrale, à 80 kilomètres de la côte et à 120 kilomètres de la 

capitale. Sa superficie communale s'élève à 97 kilomètres carrés, ce qui représente 2,15% de 

la superficie totale de la wilaya. La wilaya s'étend sur une superficie totale de 4454 kilomètres 

carrés, soit 0,19% du territoire national (QUETA, 2023). 

Selon les résultats finaux du Recensement Général de la Population et de l'Habitat 

(RGPH) d'avril 2008, la population de Bouira s'élève à 695 593 habitants. À la fin de l'année 

2008, cette population est estimée à 767 030 habitants, puis à 780 880 habitants à la fin de 

l'année 2013 et à 780 880 habitants à la fin de l'année 2014, ce qui représente une 

augmentation de 13 850 habitants. La densité de population moyenne est de 175 habitants par 

kilomètre carré (Figure 03) (SAIDI, 2016). 

 

 

 

Figure 03: Les directions cardinales et inter cardinales de la wilaya de Bouira (QUETA, 

2023). 

 

3.1.2. Cadre physique  
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La wilaya de Bouira, s'étendant partiellement sur les territoires des wilayas voisines de 

Médéa et de Tizi-Ouzou, est administrativement divisée en 12 daïras et 45 communes 

(Tableau III). Selon les données de l'Inventaire Forestier National (IFN) de 2008, la 

répartition de l'occupation du sol dans cette région est détaillée comme suit : 

Tableau III: La répartition administrative des communes au sein des différentes daïras 

de la wilaya de Bouira (QUETA, 2023). 

 

 

3.1.3. Caractéristiques générales du relief  

Le relief de la wilaya de Bouira est varié et complexe, comportant des vallées 

profondes, des ravins, des chaînes de montagnes imposantes et des collines. Voici un aperçu 

détaillé des principales caractéristiques géographiques de la région (KEDDAM et KANEM, 

2022). 

 

 

 

 

a) La Partie Nord 

Daira Communes 

Bouira Bouira  - Ait Laaziz - Ain Turk 

Haizer Haizer – Taghzout 

Bechloul Bechloul - El Adjiba - Ahl El Ksar - Ouled Rached - El Esnam 

M’chedallah M’chedallah – Saharidj – Chorfa – Aghbalou – Ahnif - Ath Mansour 

Kadiria Kadiria – Aomar - Djebahia   

Bordj Okhriss Bordj Okhriss – Mesdour - HadjraZerga - Taguedite 

Lakhdaria Lakhdaria – Boukram -  Bouderbala – Guerrouma - Z’barbar - Maala 

BirGhbalou BirGhbalou – Raouraoua - Khabouzia 

Ain Bessem Ain Bessem - Ain Laloui - Ain El Hadjar 

Souk El Khemis Souk El Khemis - El Mokrani 

El Hachimia El Hachimia - Oued El Berdi 

Sour  ElGhozlane Sour  ElGhozlane – Dechmia – Ridane – Maamora – Dirah - El Hakimia 
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 Chaîne de Djurdjura : 

o Localisation : Située au nord, elle forme une barrière naturelle entre la 

Méditerranée et le centre de la wilaya de Bouira. 

o Altitude : Le sommet de Lalla-Khedidja, le point culminant, atteint 2308 

mètres. Le chef-lieu de la wilaya est situé à une altitude de 525 mètres, au pied 

du versant sud-ouest de cette chaîne. 

 Relief Contrasté : 

o Montagnes : Djebel Bouzegza (1032 m) et Djebel Bordja (857 m). 

o Hydrographie : L'Oued Isser, qui coule initialement d'est en ouest, change de 

direction après avoir traversé les gorges de Lakhdaria. La vallée de l'Oued 

Isser abrite une nappe phréatique significative. 

 Montagnes Hellala et Koudiat-Tazzaft : 

o Altitude : Respectivement 1042 mètres et 1007 mètres. 

o Collines : Une série de collines relie ces montagnes à la plaine intérieure 

d'Ain-Bessem (altitude moyenne de 650 mètres). 

o Rivières : L'Oued-Sahel et ses affluents entre Ain-Bessem et Ain-Laloui, et 

l'Oued-Krarif et l'Oued-Zeghoua vers Bir-Ghbalou. 

b) La Partie Sud-ouest 

 Chaîne des Bibans : 

o Relief : Dominée par les Djebels Serou (1361 m) et Garn-Eslem (1317 m). 

o Climat : La présence de montagnes au nord atténue les influences 

méditerranéennes, exposant la région tantôt aux vents de l'ouest, tantôt au 

sirocco du sud. 

o Précipitations : Environ 510 mm par an, principalement d'octobre à avril, 

souvent sous forme de fortes pluies torrentielles. 

c) La Partie Est 

 Massif du Djurdjura : 

o Sommets : Djebel Haizer (2123 m), Ras Timdiouine (2305 m), et Tirourda 

(1962 m). 

o Limite : La crête formée par ces sommets marque la frontière avec la wilaya de 

Tizi-Ouzou. 
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d) La Partie Sud 

 Djebel Dirah : 

o Altitude : Culmine à 1810 mètres. 

o Géographie : Fait partie de l'ensemble montagneux s'étendant de l'Ouarsenis à 

la chaîne des Bibans, marquant la fin du Tell. 

La wilaya de Bouira présente un relief diversifié, incluant des chaînes de montagnes, 

des vallées profondes, des ravins et des collines. Les caractéristiques géographiques de cette 

région influencent fortement son climat, ses précipitations et ses conditions 

environnementales. Les montagnes du Djurdjura au nord et des Bibans au sud-ouest jouent un 

rôle crucial dans la protection de la région contre les influences climatiques extérieures, tout 

en abritant une riche biodiversité. La complexité du relief rend la gestion des ressources 

naturelles et le développement infrastructurel particulièrement importants pour la wilaya. 

3.1.4. Caractéristiques générales du climat  

3.1.4.1 La Température 

La wilaya de Bouira est caractérisée par un climat marqué par des hivers rigoureux et 

des étés chauds, avec des variations annuelles importantes. Les températures varient 

considérablement au cours de l'année, comme le montrent les données suivantes (AZZOUG 

et al., 2023) : 

 Été (mai à septembre) : Les températures peuvent atteindre entre 36,7 °C et 43,3 °C. 

 Hiver (janvier à mars) : Les températures oscillent entre 18,5 °C et 25,5 °C. 

Les températures moyennes mensuelles enregistrées en 2015 dans certaines stations de 

la wilaya sont les suivantes : 

 Station de Bouira : Températures variant de 7,5 °C à 29,3 °C. 

 Station de M’chedellah : Températures variant de 7,0 °C à 28,4 °C. 

 Station d’El-Esnam : Températures variant de 10 °C à 24,4 °C. 

 Ain Bessam : Température moyenne annuelle enregistrée de 18,1 °C. 

En ce qui concerne les ressources en eau, la wilaya de Bouira dispose d'importantes 

réserves, bien que leur utilisation ne soit pas optimale. La région est traversée par plusieurs 

bassins versants significatifs, contribuant à un apport moyen annuel d'environ 561 millions de 

m³, répartis comme suit (DJENBA, 2015) : 
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 Bassin versant de l'Isser : 135 millions de m³/an. 

 Bassin versant du Sahel Soummam : 380 millions de m³/an. 

 Bassin versant du Hodna : 35 millions de m³/an. 

 Bassin versant de l'humus : 11 millions de m³/an. 

3.1.4.2. Les Précipitations 

La wilaya de Bouira bénéficie de précipitations favorables, particulièrement dans sa 

partie nord (Atlas Blidéen et versant sud du Djurdjura) ainsi que sur une grande partie de la 

chaîne des Bibans. Les précipitations annuelles moyennes varient en fonction de la région 

(BOUCHENEB, 2014) : 

 Partie nord (Atlas Blidéen et versant sud du Djurdjura) : Moyenne de 300 à 400 

mm/an. 

 Chaîne des Bibans : Précipitations moyennes similaires. 

 Sommets du Djurdjura : Les précipitations peuvent dépasser 700 mm/an. 

 Dépression centrale : Précipitations variant entre 350 et 400 mm/an. 

 Dépression Sud Bibanique : Les précipitations les plus faibles, variant entre 200 et 

280 mm/an. 

 

Tableau 04: Température et précipitation (Année 2015) (BOUCHENEB, 2014). 

 

Mois Précipitation en 

(mm) 

Nombre de jour de 

pluie 

Températur

e 

Janvier 100,1 14 07,7 °C 

Févier 126,5 18 07,5 °C 

Mars 38,9 10 12,0 °C 

Avril 01,5 01 16,7 °C 

Mai 13,5 03 21,0 °C 

Juin 11,5 04 23,8 °C 

Juillet 00,2 00 29,3 °C 

Aout 01,2 01 28,2 °C 

Septembre 49,4 07 22,6 °C 

Octobre 40,1 10 18,4 °C 

Novembre 31,8 07 12,4 °C 

Décembre 00 00 09,8 °C 

Moyenne 

Annuelle 

498,3 - 17,5°C 

3.1.4.3 Les Vents 
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Les vents dans la région proviennent principalement de l'est et de l'ouest, avec des 

vitesses généralement modérées. Les vitesses moyennes annuelles enregistrées sont de 2,2 m/s 

à la station de Bouira et de 3,4 m/s à la station d’Ain-Bessem. Le sirocco souffle en moyenne 

4 jours par an, principalement en juillet et août (BOUCHENEB, 2014). 

3.1.4.4. La Neige 

La neige est principalement présente dans la région de Djurdjura, avec une présence 

moindre dans la région de Dirah (BOUCHENEB, 2014). 

3.1.4.5. La Grêle 

La grêle est plus fréquente entre décembre et mars, avec une moyenne annuelle de 2 

jours à Lakhdaria et de 1 à 2 jours à Sour-El-Ghozlane (BOUCHENEB, 2014). 

3.1.4.6. Les Gelées 

Les gelées blanches surviennent en moyenne de 10 à 20 jours par an, principalement 

entre novembre et avril (BOUCHENEB, 2014). 

3.1.4.7. Les Sols 

Les sols de la région varient, avec une prédominance de sols calcaires dans les zones 

montagneuses. Les plaines présentent une diversité de sols, comprenant des sols alluviaux et 

de bonnes terres de texture moyenne. La structure géographique suggère une région de 

formation récente, où les séismes sont possibles (BOUCHENEB, 2014). 

3.1.4.8. La Végétation 

La végétation varie en fonction du relief et du climat. Au sud du Djebel Dirah, la 

végétation est steppique. Dans les régions nord-est et nord-ouest, on trouve une végétation 

forestière composée de pin d'Alep, sapin, et chêne-liège. Cette végétation est présente à 

Tikjda, Haizer, Ait-Laaziz, Aomar, Begasse, Bouzegza, Maala, Guerrouma, Serou, Ksenna, 

Ahl El-Ksar, et Bordj-Okhriss. Les cultures céréalières et fruitières dominent à l'ouest (plaine 

des Arribs), au centre (zone de Bouira), et au sud-est (Sour-El-Ghozlane, Oued-Djenane). Les 

oliveraies sont vastes sur les hauteurs du nord, notamment à M'chedallah, et des cultures 

maraîchères sont présentes dans la plaine des Issers (BOUCHENEB, 2014). 

3.1.5. Hydrographie 

La wilaya de Bouira bénéficie de ressources hydriques considérables, avec des bassins 

versants importants contribuant à un apport moyen annuel d'environ 561 millions de mètres 

cubes. La répartition est la suivante (BOUCHENEB, 2014) : 
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 Bassin versant de l'Isser : 135 millions de mètres cubes par an. 

 Bassin versant du Sahel Soummam : 380 millions de mètres cubes par an. 

 Bassin versant du Hodna : 35 millions de mètres cubes par an. 

 Bassin versant de l'Humus : 11 millions de mètres cubes par an. 

La diversité climatique et hydrologique de la wilaya de Bouira influence fortement son 

agriculture, sa gestion des ressources naturelles, et son développement socio-économique. 

3.2. La base de données 

Une base de données est une compilation de données structurées de manière 

conceptuelle, décrivant les caractéristiques des données et les relations entre leurs entités 

respectives. Son objectif est de fournir une assistance dans divers domaines d'application. Par 

Oxemple, une base de données SIG (Système d'Information Géographique) contient de 

données liées à la localisation et aux attributs des caractéristiques géographiques (DEHAINS 

ALA, 2007). 

3.3. Les données dans les SIG 

3.3.1 Mode d’acquisition de donnée  

Les données géographiques proviennent de sources diverses et sont acquises de 

différentes manières, sur différents supports, qualifiées de multi-sources. Certaines données 

sont obtenues directement sur le terrain (levés topographiques) ou à distance (systèmes de 

positionnement global GPS, photographies aériennes, images satellitaires). D'autres sont 

saisies à partir de cartes ou de plans existants, ou bien collectées par des organismes 

spécialisés avant d'être importées dans les SIG. Il est nécessaire d'intégrer ces données 

disparates en raison de leurs différences de qualité, de fiabilité, de précision et d'étendue 

spatiale (URBANI, 2006). 

3.3.2 Numérisation 

La numérisation (ou vectorisation) consiste à récupérer la géométrie des objets présents 

sur un plan ou une carte existante. Elle implique le déplacement d'un curseur sur une table à 

digitaliser, préalablement calibrée en coordonnées, détectant les signaux électriques avec une 

précision d'environ un dixième de millimètre (REZEG, 2010). 
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3.3.3 Balayage électronique (scannérisation) 

Le balayage électronique, effectué à l'aide d'un scanner, est une méthode plus rapide que 

la numérisation manuelle pour capturer un plan existant (REZEG, 2010). 

3.3.4. Photogrammétrie 

La photogrammétrie aérienne est couramment utilisée pour créer des cartes à moyenne 

échelle, notamment dans les régions où la cartographie et la géodésie sont peu développées. 

Elle peut également être utilisée pour produire des plans à grande échelle à moindre coût 

(OULIDI, 2019). 

3.3.5 .Images satellitaires (télédétection) 

La télédétection, que ce soit à partir de photographies aériennes ou d'images transmises 

par satellite, est un moyen pratique de générer des données pour les SIG (OULIDI, 2019). 

3.3.6. Import de fichiers 

Cette méthode permet de réduire les coûts de saisie en récupérant des données 

existantes et en les convertissant dans le format, le système d'unités et le système de 

projection souhaités. Cela implique l'utilisation d'interfaces pour la conversion directe dans le 

format inteme du SIG récepteur ou l'utilisation d'un format d'échange reconnu par une 

fonction d'importation de données du SIG récepteur (OULIDI, 2019). 

3.4. QGIS (Quantum Geographic Information System) 

QGIS (Quantum Geographic Information System) est une application SIG (système 

d'information géographique) gratuite et open-source qui permet aux utilisateurs de créer, 

éditer, visualiser, analyser et publier des informations géospatiales (SHAIRA et al ., 2020). Il 

fonctionne sous Linux, Unix, Mac OS, Windows et Android, et prend en charge de nombreux 

formats et fonctionnalités vectoriels, raster et de base de données. Voici quelques 

caractéristiques et composants clés de QGIS Selon (ELAKKIYA, 2023) : 

1. Interface Utilisateur : QGIS offre une interface intuitive et conviviale comprenant 

des vues cartographiques, des couches, des barres d'outils et des menus pour diverses 

opérations SIG. 
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2. Prise en Charge des Couches : QGIS prend en charge une large gamme de formats 

vectoriels (points, lignes, polygones) et raster (images, grilles). Les utilisateurs 

peuvent ajouter et gérer plusieurs couches simultanément. 

3. Symbologie et Style : QGIS propose des options avancées pour la symbolisation et le 

style des couches. Les utilisateurs peuvent personnaliser les couleurs, les symboles, les 

étiquettes et plus encore pour créer des cartes visuellement attrayantes. 

4. Édition des Données : QGIS permet aux utilisateurs de créer et d'éditer des données 

vectorielles et raster. Il comprend des outils pour la numérisation de nouvelles 

fonctionnalités, la modification des fonctionnalités existantes et la réalisation 

d'analyses géospatiales. 

5. Plugins : La fonctionnalité de QGIS peut être étendue grâce à des plugins. La 

communauté QGIS a développé de nombreux plugins pour des tâches telles que le 

géotraitement, le géocodage, l'analyse de réseau et plus encore. 

6. Géotraitement : QGIS comprend un ensemble complet d'outils de géotraitement pour 

des tâches telles que la création de tampons, la découpe, l'intersection et la fusion de 

jeux de données. Il prend également en charge l'intégration avec d'autres outils SIG 

comme GRASS GIS et SAGA GIS. 

7. Systèmes de Référence de Coordonnées : QGIS prend en charge divers systèmes de 

référence de coordonnées (SRC) et permet la projection à la volée des données pour 

garantir une cartographie et une analyse précises. 

8. Cartographie Web : QGIS peut être utilisé pour publier des cartes et des données 

géospatiales sur le web en utilisant des outils comme QGIS Server et QGIS Cloud. 

Cela permet de partager des cartes avec un public plus large. 

9. Visualisation et Analyse des Données : QGIS fournit des outils pour l'analyse 

spatiale, y compris l'analyse de superposition, l'analyse de proximité et l'analyse 

statistique. Les utilisateurs peuvent également créer des graphiques pour visualiser les 

données. 

10. Communauté et Documentation : QGIS dispose d'une forte communauté 

d'utilisateurs et d'une documentation extensive, y compris des manuels utilisateurs, des 
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tutoriels et des forums, qui offrent un support et des ressources pour les utilisateurs de 

tous niveaux. 

QGIS est largement utilisé dans divers domaines tels que la planification urbaine, les 

sciences de l'environnement, l'agriculture, la foresterie et bien plus en raison de sa 

polyvalence et de ses capacités robustes. 

3.5. Traitement des données satellitaires 

3.5.1. Prétraitement des images satellitaires 

a) Corrections géométriques 

Les images capturées par les systèmes d'observation terrestre ne peuvent être 

directement superposées aux cartes en raison de déformations géométriques. Ces 

déformations résultent d'erreurs de positionnement du satellite, de la rotation de la Terre 

pendant l'enregistrement de l'image, des effets du relief terrestre, etc. Les satellites prenant 

parfois des images en oblique, ces déformations peuvent être accentuées. Certaines 

déformations sont prévisibles et peuvent être corrigées systématiquement (DAGORNE, 

1988). 

b) Corrections radiométriques 

Un système d'observation terrestre idéal mesurerait précisément et uniformément 

l'énergie réfléchie par les objets. Cependant, la lumière solaire traversant l'atmosphère altère 

les mesures en raison de la diffusion et de l'absorption par les gaz et les particules 

atmosphériques. Le traitement électronique des données capturées par les capteurs est 

également sujet à des perturbations, rendant la détermination précise des valeurs 

radiométriques difficile. Les corrections radiométriques reposent sur des modèles 

mathématiques complexes ou sur l'observation de cibles de référence avec une radiométrie 

connue (PELLETIER, 2017). 

3.5.2 Géo référencement des images satellitaires 

Les images satellitaires fournies brutes présentent des déformations spatiales dues à 

divers paramètres tels que les variations d'altitude du satellite, les imperfections de ses 

capteurs, l'inclinaison de son orbite, et des facteurs terrestres comme la forme de l'ellipsoïde et 
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les reliefs. Pour superposer deux images avec précision ou les aligner avec une carte 

topographique, les images doivent être corrigées géométriquement des effets de ces 

déformations systématiques (LATIFOVIC et al , 2005). 

3.5.3 Classification des images satellitaires 

L'analyse de la dynamique du couvert végétal repose sur une classification précise des 

unités présentes sur une image. Cette classification, utilisée pour produire des cartes 

thématiques, peut être réalisée sur un ou plusieurs canaux d'une image afin de séparer les 

différents éléments en fonction de leurs caractéristiques spectrales (PONY et al., 2000). 

a) Classification non supervisée 

Les classes spectrales sont formées sur la base de l'information numérique des données. 

Un analyste associe ensuite ces classes à des classes d'information utile. Les algorithmes de 

classification déterminent les groupes statistiques naturels ou les structures des données. Ce 

processus itératif peut nécessiter des ajustements et de nouvelles applications de l'algorithme 

(CAMPEDEL et MOULINES, 2005). 

b) Classification supervisée 

L'analyste identifie des échantillons homogènes de l'image représentant différents types 

de surfaces, formant un ensemble de données-tests. Ces échantillons sont sélectionnés en 

fonction des connaissances de l'analyste. L'ordinateur utilise ces données pour définir les 

classes et reconnaître des régions présentant des propriétés similaires. Une fois la signature 

spectrale de chaque classe établie, l'ordinateur attribue chaque pixel de l'image à la classe 

correspondante (CAMPEDEL et MOULINES, 2005). 

3.5.4. Les Images Satellitaires 

 Landsat-8 

Landsat-8 lancé par la NASA en 2013, permet d'acquérir des images tous les seize jours 

avec une fauchée de 185 km. Il embarque deux capteurs (EL GAROUANI et al., 2008) : 

1. Operational Land Imager (OLI) : Résolutions et bandes spectrales variées (30 m 

pour les multispectrales, 15 m pour le panchromatique) 
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2. Thermal Infra-Red Sensor (TIRS) : Acquisition en infrarouge thermique avec une 

résolution de 100 m 

Tableau 05: Différents capteurs multi spectraux et résolutions spatiales (KALI-KELE, 

2023). 

Satellite 
 

Capteur 

 

 

 
Résolution-Sol 

Meteosat 11 

 

Seviri 1 km 

PROBA-V 

 

VEGETATION 100 m - 300 m 

Landsat 8 

 

TIRS 

 

100 m 
 

Landsat 4 

 

MSS 

 

80 m 
 

Landsat 4 

 

Thematic Mapper 30 m 
 

Landsat 8 

 

OLI Multispectral 30 m 

SPOT 3 

 

HRV Multispectral 20 m 

Landsat 8 

 

OLI Panchromatique 15 m 

SPOT 3 

 

HRV Panchromatique 10 m 

SPOT 6&7 

 

Multispectral 6 m 

Pléiades 

 

Multispectral 2 m 

SPOT 6&7 Panchromatique 1,5 m 

Pléiades Panchromatique 0,70 m 

 

 Sentinel-2 

C'est une série de satellites d'observation de la Terre développés par l'Agence spatiale 

européenne (ESA). Les satellites Sentinel-2 sont équipés de capteurs optiques multispectraux 

qui captent des images haute résolution de la surface terrestre. Ils sont utilisés pour diverses 

applications telles que la surveillance de l'usage des terres, la gestion des ressources 

naturelles, la cartographie environnementale, et la réponse aux crises humanitaires 

(ZAABAR, 2022). 
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 Sentinel-3 

Également faisant partie du programme Copernicus, Sentinel-3 est une série de satellites 

conçus pour observer les océans et la surface terrestre. Ces satellites fournissent des données 

précieuses pour surveiller les changements climatiques, l'océanographie, la qualité de l'eau et 

d'autres paramètres environnementaux essentiels à travers des instruments avancés tels que 

des radiomètres et des altimètres (PINSAULT et al ., 2022). 

 Semi classification plugin (SCP)  

Est un outil puissant intégré dans le logiciel QGIS, conçu pour simplifier et améliorer le 

processus de classification d'images de télédétection. Ce plugin est particulièrement utile pour 

les chercheurs et les professionnels travaillant dans les domaines de l'analyse des 

changements d'occupation du sol, de l'écologie, de l'agriculture, et de la gestion des ressources 

naturelles. Voici un aperçu des fonctionnalités et des avantages du SCP (EL GAROUANI et 

al., 2008)   : 

 Fonctionnalités principales  

1. Prétraitement des images  

o Importation des données : L'importation d'images de différents satellites 

(Landsat, Sentinel, etc.) et formats (GeoTIFF, HDF, etc.) est possible grâce au 

SCP. 

o Correction radiométrique et atmosphérique : L'outil facilite les corrections 

nécessaires pour améliorer la qualité des images et assurer leur compatibilité 

pour les analyses ultérieures. 

o Géoréférencement : Assure que les images sont correctement alignées avec 

les coordonnées géographiques. 

2. Création de classes de formation : 

o Sélection des échantillons : Les usagers ont la possibilité de choisir de 

manière manuelle des échantillons de pixels afin de générer des classes de 

formation qui reposent sur des caractéristiques spectrales particulières. 



Chapitre III                                                                          Matériel et Méthodes  

 

 Page 31 
 

o Automatisation : Possibilité d'utiliser des algorithmes automatiques pour 

détecter et créer des classes de formation à partir de grandes zones. 

3. Classification d'images : 

o Classification supervisée : Diffuse l'ensemble de l'image en différentes 

catégories d'occupation du sol (forêt, eau, zones urbaines, etc.) en utilisant des 

échantillons de formation. 

o Classification non supervisée : Applique des algorithmes tels que K-means 

pour identifier des clusters naturels de pixels sans échantillons de formation 

préalables. 

4. Algorithmes avancés : Intégration de différentes méthodes de classification telles que 

la classification par arbre de décision, la forêt à événements inattendus et les machines 

à support vectoriel (SVM). 

5. Post-traitement et analyse : 

o Évaluation de l'exactitude : Amélioration de la précision des classifications 

en créant des matrices de confusion et en calculant des indices tels que l'indice 

Kappa. 

o Cartographie : Création de cartes thématiques détaillées représentant les 

différentes classes d'occupation du sol. 

o Analyse temporelle : Comparaison de différentes périodes pour analyser les 

changements dans l'occupation du sol au fil du temps. 

6. Gestion des données : 

o Base de données intégrée : Efficacité dans le stockage et la gestion des 

images et des résultats de classification. 

o Interfaçage avec d'autres outils SIG : Intégration facile avec d'autres plugins 

QGIS et outils SIG pour une analyse spatiale plus approfondie. 
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 Avantages : 

 Accessibilité et facilité d'utilisation : SCP est conçu pour être convivial, même pour 

les utilisateurs ayant une connaissance limitée de la télédétection et des SIG. 

 Automatisation et efficacité : Les caractéristiques automatisées permettent de 

diminuer le temps et les efforts requis pour traiter et analyser les images. 

 Précision et fiabilité : Les algorithmes avancés et les outils de prétraitement 

améliorent la précision des classifications et des analyses. 

 Flexibilité : Compatible avec une large gamme de données satellitaires et formats 

d'image, permettant une utilisation dans divers contextes géographiques et 

thématiques. 

Ce résumé présente une synthèse des buts des SIG et des utilisations de la télédétection, 

soulignant leur importance dans la gestion et l'analyse des données géographiques. 

 Google Earth et USGS Earth 

Il permet aux utilisateurs d'explorer des cartes mondiales, le terrain et les vues de rue, 

ainsi que de créer des cartes personnalisées en marquant des lieux et en ajoutant des 

informations. Google Earth propose également des images historiques pour observer les 

changements au fil du temps et prend en charge des couches pour différents types 

d'informations telles que les routes, les frontières et les points d'intérêt. En revanche, l'USGS 

Earth Explorer, une plateforme web, donne accès à une grande variété de données de 

télédétection, y compris des images satellites, des photographies aériennes et des modèles 

numériques de terrain. Les utilisateurs peuvent rechercher et télécharger des données de 

sources diverses comme Landsat, Sentinel et MODIS, en se basant sur une zone 

géographique, une plage de dates et un type de jeu de données (MOORE, 2011). 

Earth Explorer offre également des outils pour visualiser et analyser les données 

directement dans le navigateur, ce qui en fait un outil précieux pour la recherche scientifique, 

la gestion des terres et la planification. Tandis que Google Earth est idéal pour l'exploration 

décontractée, l'éducation et la création de visualisations, USGS Earth Explorer est plus adapté 

aux professionnels et aux chercheurs nécessitant un accès à des données géospatiales 

détaillées (YUNIAWATIKA et al., 2023). 
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Logiciel statistiques R 

R est un langage de programmation et un environnement logiciel utilisé principalement 

pour l'analyse statistique et la visualisation de données. Voici quelques points clés à savoir sur 

R (HUSSON et al., 2018) : 

1. Gratuit et Open Source : R est gratuit à télécharger et à utiliser, et il est maintenu par 

une communauté de développeurs dans le monde entier. 

2. Large Écosystème : Il dispose d'une vaste bibliothèque de packages pour diverses 

analyses statistiques, modèles prédictifs, graphiques et plus encore. 

3. Flexibilité : R est extrêmement flexible, permettant aux utilisateurs de créer leurs 

propres fonctions et packages pour répondre à des besoins spécifiques. 

4. Interface : Il peut être utilisé en ligne de commande, mais il est souvent utilisé avec 

des interfaces utilisateur comme RStudio, qui facilitent l'écriture de code, la 

visualisation de données et l'organisation de projets. 

5. Graphiques : R est réputé pour ses capacités de visualisation avancées, permettant de 

créer des graphiques statistiques complexes et personnalisables. 

Pour commencer avec R, vous pouvez télécharger R à partir de CRAN 

(Comprehensive R Archive Network) et utiliser RStudio comme interface de 

développement. 

3.6. Méthodologies 

1. Téléchargement des Images Satellitaires 

Ouvrir Google Earth Explorer. 

• Télécharger les images satellites de la zone d'étude en sélectionnant celles qui offrent une 

bonne résolution et une couverture temporelle adéquate. Les dates spécifiques des images à 

utiliser sont les suivantes : 

- 10/05/2016 

- 22/06/2020 

- 17/06/2024 

2. Ouverture d'un Nouveau Projet dans QGIS 

Lancer QGIS et créer un nouveau projet : 

- Ouvrir QGIS. 
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- Créer un nouveau projet en sélectionnant Projet > Nouveau. 

 

 

 

Figure 04: Interface de QGIS avec un nouveau projet ouvert (Originale,2024). 

 

3. Importation des Images Satellitaires dans QGIS 

-  Importer les images satellites dans QGIS : 

- Dans QGIS, allez dans Layer> Add Layer> Add Raster Layer pour importer les 

images satellites. 

 

 

Figure 05 : Interface d’importation des images satellites dans QGIS (Originale, 2024) 
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4. Mosaïquage des Images (si nécessaire) 

- Créer une mosaïque des images satellites : 

- Si vous avez plusieurs images couvrant différentes parties de la zone d'étude, utilisez 

l'outil de mosaïque pour les combiner en une seule image. 

- Allez dans Raster > Miscellaneous > Merge pour combiner les images. 

 

 

 

Figure 06 : Interface de l'outil de mosaïquage dans QGIS (Originale ,2024). 

 

 

 

5. Importation du Fichier Vecteur Bonira Shapefile  

• Importer le fichier vecteur Bouira Shapefile :  

- Allez dans Layer > Add Layer > Add Vector Layer pour importer le fichier 

Shapefile de Bouira.  

- Sélectionnez le fichier Shapefile de Bouin et cliquez sur Ouvrir pour l'ajouter à 

votre projet QGIS. 
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Figure 07 : interface importation du fichier vecteur Bouira Shapefile (Originale ,2024) 

 

6. Extraction et Découpe du Raster selon un Couch er de Masques  

• Extraire et découper le raster selon un coucher de masques :  

- Sélectionnez le raster à découper et le fichier vecteur de masques (par exemple, le 

Shapefile de Bouira) pour définir les limites de découpe.  

- Allez dans Raster> Extraction > Clipper pour ouvrir l'outil de découpe.  

- Dans la fenêtre de l'outil de découpe, sélectionnez l'option Mask layer et 

choisissez le fichier vecteur de masques.  

- Cliquez sur Run pour effectuer la découpe. 
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Figure 08 : Interface de l'outil de découpe dans QGIS (Originale ,2024). 

7. Application de la Classification Supervisée  

• Appliquer la classification supervisée :  

- Utilisez un algorithme de classification non supervisée, comme K-means, pour 

identifier les différentes classes d'occupation du sol.  

- Allez dans Raster > Analysis > Clustering K-means ou utilisez le plugin Sem i-

Automatic Classification Phigin (SCP).  

- Configurez les paramètres nécessaires pour le nombre de classes et d'autres 

options spécifiques à l'algorithme choisi.  

           Cliquez sur Run pour lancer la classification. 

 

 

 

 

 

 

 

 

 

Figure 09 : Interface de l'outil de classification non supervisée dans QGIS 

(Originale ,2024). 
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8. Étiquetage des Classes 

 Étiqueter les classes d'occupation du sol : 

o Interprétez les classes identifiées par l'algorithme de classification non 

supervisée. 

o Assignez des étiquettes descriptives aux classes en fonction de leur 

caractéristique d'occupation du sol. 

 Exemples d'étiquettes : water, Forest, Grass, Crop, Shrubs, Build 

area, Bare soil, Snow. 

 
 

Figure 10 : interface d’étiquetage des classes dans QGIS (Originale, 2024) 

 

9. Validation des Résultats 

 Valider les résultats de la classification : 

o Comparez les résultats de la classification avec des données de référence, telles 

que des relevés de terrain ou des images satellitaires de haute résolution, pour 

valider l'exactitude de la classification. 

o Utilisez des matrices de confusion pour évaluer la précision globale, la 

précision utilisateur et la précision producteur des classes. 

o Ajustez les paramètres de classification si nécessaire pour améliorer la 

précision. 
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Figure 11 : Résultats de la validation avec comparaison des données de référence ( Original, 2024). 
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Nous avons sélectionné la zone d'étude de Bourra AFM de réaliser une analyse des 

changements d'occupation du sol sur les années 2016, 2020 et 2024. Cette étude nous permette 

de comprendre les dynamiques d'évolution des différentes classes d'occupation du sol, telles que 

l'eau, la forêt, les herbes, les cultures, les arbustes, les zones bâties, le sol nu, et la neige 

 

 

 

 

 

 

 

 

Figure12 : Carte d’Occupation du sol en 2016 
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Figure13 : Carte d’Occupation du sol en 2016 

Figure14 : Carte d’Occupation du sol en 2024 
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4.1.Changement de la couverture terrestre de 2016 à 2020 

L'analyse de la couverture terrestre sur la période de 2016 à 2020 a révélé les changements 

suivants en termes de pourcentage : 

Tableau  VI : Changement de la Couverture Terrestre de 2016 à 2020. 

Year 2016 Year 2020 Difference % Difference 

1 0 0 0 0 

2 1192182,4 1044409,8 11,1 -12,3951335 

3 102243,6 201178,8 2,1 96,76419844 

4 610,1 126,9 0 -79,20013113 

5 1028944,8 897886,4 9,6 -12,7371653 

6 1515501,6 1615522,9 17,2 6,599880858 

7 385260,7 283225,7 3 -26,4846635 

8 753554,6 930709,9 9,9 23,50928519 

9 761,3 0,6 0 -99,92118744 

       Water : La couverture terrestre a diminue de 1 192 182,4 m2 en 2016 à 1 044 409,8 mP en 

2020.La surface a diminué de 147 772,6 m2, soit une baisse de 12,40 %. Selon (NGUYEN et 

aL, 2018) cette diminution pourrait être due à des activités anthropiques telles que l'urbanisation 

ou des changements dans l'utilisation des terres.  

       Forest : La couverture terrestre a presque doublé, passant de 102 243,6 m2 en 2016 a 201 

178,8 m2 en 2020 .La surface a presque doublé, avec une augmentation de 98 935,2 m2, soit 

96,76 %. Selon (LEBLANC, 2013) cela pourrait indiquer une croissance de la végétation ou une 

expansion des zones agricoles. 

     Grass : La couverture terrestre a diminué de manière significative, passant de 610,1 m² en 

2016 à 126,9 m² en 2020 . La surface a fortement diminué de 483,2 m², soit une baisse de 79,20 

%. Selon (FOURNIER et al., 2013) cela pourrait être dû à la réduction des surfaces forestières 

ou à des changements dans les pratiques de gestion des terres. 

Crop : La couverture terrestre a diminué de 1 028 944,8 m² en 2016 à 897 886,4 m² en 

2020, soit une diminution de 12,74 %. Soit une baisse de 12,74 %. Cette diminution peut être 

liée à une conversion des terres agricoles en zones bâties ou à une diminution de la couverture 

végétale (NGUYEN et al., 2018). 
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         Shrubs : La couverture terrestre a augmenté de 1 515 501,6 m2 en 2016 à 1 615 522,9 m2 

en 2020, soit une augmentation de 6,60 %. Selon (NGUYEN et al., 2018) cette augmentation 

peut être due à une expansion des zones bâties ou à une augmentation des activités agricoles. 

         Buld area : La couverture terrestre a diminué de 385 260,7 m2 en 2016 à 283 225,7 m2 en 

2020, soit une diminution de 26,48 %. Selon (LEPART et al., 2014) cela pourrait être attribué à 

la diminution des zones urbaines ou à des efforts de reforestation. 

         Bare Soil: La couverture terrestre a augmenté de 753 554,6 m2 en 2016 à 930 709,9 m2 en 

2020, soit une augmentation de 23,51 %.Selon (NJOGI BELLA et al, 2020) Cela pourrait 

indiquer des activités de construction ou des processus naturels d'érosion et de dépôt de sol. 

         Snow : La couverture terrestre a diminué de 761,3 m2 en 2016 à 0,6 m2 en 2020, soit une 

diminution de 99,92 %. Selon (MOREL, 2007) Cette diminution pourrait être due aux 

changements climatiques affectant la présence de neige dans la région. 

Ces résultats indiquent des changements significatifs dans certaines classes d'occupation du 

sol, avec des augmentations notables dans certaines zones (comme la classe Forest) et des 

diminutions importantes dans d'autres (comme la classe Grass et Build Area). Ces résultats 

mettent en lumière l'importance de surveiller les changements dans la couverture terrestre pour 

comprendre les dynamiques environnementales dynamiques environnementales et socio-

économiques. Les augmentations et diminutions observées dans les différentes classes 

d'occupation du sol indiquent des tendances qui pourraient nécessiter des interventions 

spécifiques en matière de gestion des terres et de conservation des ressources naturelles. 
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4.2. Changement de la Couverture Terrestre de 2020 à 2024 

L'analyse de la couverture terrestre de 2020à 2024 montre les changements suivants : 

Tableau VII: Changement de la Couverture Terrestre de 2020 à 2024. 

Year 2020 Year 2024 Difference % Difference 

1 0 0 0 0 

2 1192182,3 961484,2 10,3 -19,35090799 

3 102243,7 50643,6 0,5 -50,46775498 

4 610,2 192,6 0 -68,43657817 

5 1028944,9 1292655,4 13,8 25,62921494 

6 1515501,8 1393715,5 14,9 -8,036037964 

7 385260,8 379693,8 4,1 -1,444995182 

8 753554,5 910162,1 9,7 20,78251805 

9 761,2 193,9 0 -74,52706253 

 

Les résultats montrent des variations significatives dans la couverture terrestre entre 2020 

et 2024 : 

Water: Une diminution de 230 698,1 m2, soit -19,35 %. Cela pourrait indiquer une 

réduction des zones agricoles ou une conversion vers d'autres utilisations des terres (NGUYEN 

et al., 2018). 

Forest : Une diminution marquée de 51 600,1 m2, soit -50,47 %. Selon (BELTRAME, 

2015) Cette diminution pourrait être due à des changements dans les pratiques agricoles ou à une 

expansion urbaine.Grass: Une diminution significative de 417,6 m2, soit -68,44 %. Cela pourrait 

refléter une diminution des zones forestières ou des changements dans la gestion des terres. 

 Crop : Une augmentation de 263 710,5 m², soit 25,63 %. Cela pourrait indiquer une 

croissance de la végétation ou une expansion des zones agricoles. 

 Shrubs : Une diminution de 121 786,3 m², soit -8,04 %. Selon (BARLES,2017) Cette 

diminution pourrait être liée à une diminution des zones bâties ou à des changements dans les 

activités industrielles. 



Chapitre IV                                                                              Résultat et discussion  

 

 Page 46 
 

Build Area : Une légère diminution de 5 567,0 m², soit -1,44 %. Selon (OUEDRAOGO et 

al ., 2015)  Cette variation pourrait être due à des ajustements mineurs dans les zones urbaines ou 

à des projets de conservation. 

Bare Soil : Une augmentation de 156 607,6 m², soit 20,78 %.Selon (OUEDRAOGO et al 

., 2024) Cela pourrait indiquer une expansion urbaine ou une augmentation des infrastructures. 

Snow : Une diminution de 567,3 m², soit -74,53 %. Cette baisse pourrait être attribuée à 

des changements dans l'utilisation des terres ou à des mesures de restauration écologique. 

Ces résultats soulignent l'importance de surveiller et de comprendre les changements dans 

la couverture terrestre pour une gestion durable des ressources naturelles et pour répondre aux 

défis environnementaux et socio-économiques à long terme. 

4.3. Comparaison entre les Deux Périodes 

 Les résultats montrent des variations significatives dans la couverture terrestre entre 2016-

2020 et 2020-2024. Certaines classes comme Forest ont subi une diminution continue, passant de 

96,76 % d'augmentation à une baisse de 50,47 %. D'autres classes comme Grass ont montré une 

diminution initiale suivie par une croissance importante. 

- Water a connu une diminution continue, mettant en lumière des défis persistants 

en termes de gestion des ressources en eau. 

- Forest et Grass présentent des tendances opposées entre les deux périodes, avec 

une croissance initiale suivie d'une diminution pour Forest, et une diminution initiale 

suivie d'une augmentation pour Grass. 

- Crop et Build Area montrent une croissance dans la deuxième période, ce qui 

pourrait indiquer une expansion des activités agricoles et urbaines. 

- Shrubs et Bare Soil montrent des diminutions, soulignant des changements 

potentiels dans l'utilisation des terres ou des efforts de conservation. 

Ces résultats soulignent l'importance de surveiller et de comprendre les changements dans 

la couverture terrestre pour une gestion durable des ressources naturelles et pour répondre aux 

défis environnementaux et socio-économiques à long terme. 
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         Cette étude révèle les dynamiques complexes et interconnectées des changements 

d'occupation du sol dans la wilaya de Bouira, soulignant la nécessité de stratégies intégrées et 

de collaborations multisectorielles pour garantir une gestion durable des ressources naturelles 

et le développement socio-économique de la région. Les changements observés mettent en 

évidence l'importance de la surveillance continue et de l'analyse des dynamiques d'occupation 

du sol. Ils soulignent également le besoin de politiques et de pratiques de gestion des terres 

adaptatives et durables pour relever les défis environnementaux et socio-économiques. Les 

tendances identifiées suggèrent des zones prioritaires pour l'intervention, telles que la 

conservation des ressources en eau, la gestion forestière et la protection des terres agricoles. 

L’étude des changements d'occupation du sol dans la wilaya de Bouira pour les années 2016, 

2020 et 2024 a révélé des dynamiques complexes et significatives, soulignant l'importance de 

la gestion durable des ressources naturelles et des terres. Les résultats montrent des variations 

notables dans les différentes classes d'occupation du sol, reflétant des tendances socio-

économiques et environnementales importantes. 

        Pour répondre à ces défis, plusieurs recommandations sont proposées : renforcer la 

gestion de l'eau en mettant en place des politiques et des infrastructures pour une gestion 

efficace et durable des ressources en eau, incluant des stratégies de conservation et de 

réutilisation ; promouvoir la reforestation et la conservation des forêts afin d'améliorer la 

biodiversité et les services écosystémiques ; optimiser l'utilisation des terres agricoles en 

adoptant des pratiques agricoles durables pour augmenter la productivité tout en minimisant 

l'impact environnemental ; surveiller les changements climatiques en renforçant la recherche 

et la surveillance des impacts du changement climatique sur les différentes classes 

d'occupation du sol, notamment la neige ; et développer des politiques urbaines durables en 

planifiant et développant des zones urbaines de manière à minimiser l'impact sur les 

ressources naturelles et à promouvoir des espaces verts. Ces recommandations visent à 

orienter les politiques et les actions futures pour favoriser une gestion intégrée et durable des 

ressources naturelles dans la wilaya de Bouira. 
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